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Indexing Procedures Using MS Word 

Introduction 

Thank you for volunteering your efforts for the Cobb County Indexing Project!  Your work is invaluable 

and greatly appreciated.   

Please read all the indexing procedures on these pages and follow them consistently.  The various details 

about punctuation codes and formatting are required for the software to convert your hard work into a 

fine, useful product that researchers will use for years to come.  If you have any difficulty understanding 

the instructions, please contact your Project Manager.   

When you index 50 or more pages in a book you will be named as a participant on the index title page or 

referenced addendum. For more information about the indexing project, see Definitions & 

Responsibilities, page 10. 

Locate an indexing topic quickly 

In addition to using the Table of Contents, you can locate a topic in these instructions by having Word 

search for it.  Press and hold down the Control key (Apple key on a Mac) and then press and release the F 

key.  In the window that appears, type the word(s) you want to find and press Enter. 

Progress reporting 

 Send a copy of your first 10 to 20 finished pages to your Book Project Manager for evaluation. 

 Each weekend, report to BPM the cumulative (overall) number of pages you have indexed. 

Recommended basic formatting (not required) 

 Page margins:  0.5 inch on all sides 

 Font: Times Roman or Times New Roman 

 Font size: 11 or 12 pt 

 Line spacing: single 

 TIP: For easier data entry, try one of the following: 
o Enlarge the display of your worksheet to about 200% 

o Change to a larger font size (it can be changed back to 12 pt when you are finished). 
 

Note: Never select enter at the end of a line of text. Let the text wrap to the next line. 

Entering data from page images 

1. Enter your names on the template provided by the Project Manager.  Be sure the page number 

shown on the image matches the page number on the template. 
 

2.  NOTE:  If a page is missing in the image collection:    
 

a.  Do no delete the page on the template. Instead; 

b. Type: “AAMissing” between the row of asterisks in the place of names if the page is lost. 

c.   On occasions the clerk may jump pages numbers, i.e., 429-440. Thus a line and entry for 

every jumped paged is required.  Enter  “AAjumped”. 
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3. Enter names in the order they appear on the page, with a comma separating full names.   

NOTE: Some names will need other punctuation prior to the comma.  See Punctuation codes 

and highlighting (page 4). 

4. Insert only a single space between names. 

Data entry examples: 

******************************************************************** 
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Thomas Davis, Albridgton Jones, Jesse Browne, Charles Portlock, Henry Applewhaite, John 

Mundall, Elias Love, Joshua Dawson, Charles Cosby, John Boykin, John Edwards, Thomas Blake, 

Solomon Deloach, Edmund Tyler, John Watkins, Simmons:?, John Davis, John Scarry?, Jephtha 

Atherton, Thomas Gilliam, David Edmunds, Ambrouse Williams, 

******************************************************************** 
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AAMISSING 

********************************************************************* 
One of the biggest problems with indexing in WORD, is the automatic creation of a border line in place of the 

index line or asterisk row.  This happens if one selects “enter” at the end of an asterisk row.  It can be 
corrected if discovered immediately by the “back arrow”, but once embedded in the text, it is 
difficult to remove.  Remember the asterisk row is what is counting the pages.  The program does 
not see the actual page number entered on the template.  It is looking at the number of asterisk 
rows.  On the contrary, the program does not see the border line and therefore can cause a faulty 
page number entry.  You can disable this feature by following the instructions below. 

Asterisk line fix 

To prevent the line of asterisks from automatically extending the full width of the page, you will need to 

disable the automatic border feature in Word as follows:  

 In Word 2000:  

Format > AutoFormat > Options > AutoFormat as you type tab > uncheck Borders > select OK.  

 In Word 2007:  

Office button (upper left corner) > Word options button (lower right corner) > Proofing (from left 

menu)> AutoCorrect Options button> Auto Format as you type tab > uncheck Border Lines > 

select OK. 

 In Word 2008 (Macintosh): 

Tools > AutoCorrect > AutoFormat as you type tab > uncheck Borders > select OK. 
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Preliminary editing  

If you notice that you have made an error or misinterpreted a name, feel free to edit it immediately.  
Alternatively, you can make a note about it (see Comments and questions below).  However, it is 
important to edit your work formally when you have finished entering all the names.  See Full edit 
of your worksheet file (page 9). 

Comments and questions  

If, as you enter data, you have comments or questions about your data entry, put these at the beginning of 

the first page of your worksheet file, not on the page where you are entering names. 

Punctuation codes and highlighting 

In some cases, more than one punctuation code will be needed for a name.  DO NOT type spaces between 

these codes or between the name and the code(s). 

Code Usage 

Comma (,) 

To mark the end of an entry only, not for any other purpose.  

Do NOT type a space anywhere between the name and the comma.  In some 

names, other coding punctuation will come BEFORE the comma. 

ALWAYS have the comma as the last character. 

Period (.) 

Do NOT use a period anywhere on your worksheet.  Doing so 

may cause a problem with the indexing program.  All indexers 

should search and delete/correct all period entries in their work 

sheets, before submitting to BPM managers. 

Colon or semicolon  
(:) (;) 

At the end of a single (solitary) name; i.e., a first name without a 

last name or vice versa. Examples:  

Priscilla:,      

Smith:, 

Exception:  

See Name divided between two pages (page 6). 

Plus sign (+) 
Any person of African descent,    Examples:    

Betsey:+,    David Artis+,  

Question mark (?) 

At the end of each name or initial that is uncertain. With some 

uncertain names, other punctuation coding will need to come 

BEFORE the question mark (see Uncertain name, page 6).  

Red text or highlight (optional) may be helpful in locating these 

during Full edit (see page 9).  You can also use the search feature 

in Word to locate all the question marks.  Examples: 

Jaquelin? E? Jelks,    

Josiah Manry?,  

 

Highlighting 

In addition to marking an uncertain name with a question mark, 

you can highlight it. If you later discover what the name should 

be, you can easily find it again and correct it.  Example: 

River? Barker,  

Space ( ) 

The space plays an key role in the indexing program, so it is 

important to use only a single space and to use it only in these 

two situations: 
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 Between first name, initial(s), and surname.  Examples:  

B Smith,  

John Jones,  

G A W Newsom, 

 Following the comma at the end of an entry (except the 

last entry from a page) 

 

CAUTION: Be careful not to insert a space anywhere 

between the last letter of a name and the comma that 

follows that name.  A space in that location can wreck that 

name entry in the index. 

Quotation marks Do not use. 

Parentheses 
Do not use except as indicated in "Prefixes and suffixes" (page 6) 

and “Named and unnamed spouses” (page 6). 

 

Name Indexing 

Single (solitary) name 

This may be either a first name or a surname. See also Name divided between two pages (below). 

1. Type a colon (:) or (;) immediately after the name (no space).  

2. Add further punctuation code(s) as needed for the following: 

 Person of African descent, Add a plus sign (+) before the comma. 

Examples: 

Original You enter 

Hardeman Hardeman:, 

Lucy Towns,  (colored) Lucy Towns:+,          

Bailey vs Jones Bailey:, Jones:, 

 

Name with more than one initial 

Type a space between the initials.  Do not type periods after initials.  Examples: 

 G W Smith (not GW Smith) 

 John A W Jones (not John AW Jones)  

Name divided between two pages 
If a person's first name is on one page and the last name is on the next page, transfer the first name to the 

next page.  That is, index it as if the entire name had been on the second page. 

Uncertain name 

It is important to flag each first or last name that you cannot decipher.  Later, when you discover 

what the name should be, you can easily find it and correct it.  Flag an uncertain name in one of these two 

ways: 

 Enter a question mark (?)after the uncertain name. In some cases, additional punctuation codes 

may be needed before or after the question mark, as indicated in the examples below.    
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 It is not required, but a good idea to also highlight the name in yellow or some other color that is 

easy for you to see.  Understand that the ? mark is primary.               

NOTE: The indexing program ignores the color. It is only for your benefit in editing. 

Examples of uncertain names:  

 Exum? Walker, (Ex 1
st
 name unreadable) 

 John Tayor?,     (Ex surname unreadable) 

 Jock: Maseen?+, (colored) 

Surname spelling  
If a surname is (or may be) misspelled, enter the full name with both the original and the “corrected” 

spellings.  Put a question mark (?) after both entries.  For easier editing, put the corrected name in a 

colored font, preferably green.  Examples: 

Original You enter 

John Forguson John Forguson?, John Ferguson?, 

 

Multiple occurrences on a page 

If a name occurs more than once on a page, enter it only once. 

Prefixes and suffixes  

Omit prefixes and suffixes of names unless only the last name is given.  Examples: 

Original You enter 

Mr. John Smith John Smith, 

John Brantley, Jr. John Brantley, 

Mr. Brantley Mr Brantley, 

Mrs. John Smith  John Smith, 

 

Named and unnamed spouses and children 
If the first name of a wife is given, index her as a separate individual (without a prefix).  If she is 

mentioned as “wife” but not named, do not index her.   Always enter her surname if implied. 

Examples:   

Original You enter 

Mrs. John Smith  

(but Mr. Smith is not 

mentioned on the page) 

One of these two options: 

 John Smith, 

 John (Mrs) Smith, 

  John Lewis and wife Ann John Lewis, Ann Lewis, 

  John Lewis and wife  John Lewis,  

John, Samuel, Robert and Jacob Brantley 
John Brantley, Samuel Brantley, 

Robert Brantley, Jacob Brantley, 
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Orphaned children 
If the word “orphan” or “orphans” appears in a record, enter it in lower case followed by the surname.  In 

addition, if the name of an orphan or parent is given, index it as usual. 

Examples: 

Original You enter 

orphans of J. M. Davis orphans Davis, J M Davis,  

Ann and George Davis, orphans of John Davis Ann Davis, George Davis, orphans Davis, John Davis, 

George, orphan of John Davis George Davis, orphan Davis, John Davis, 

 

Non-repeated last name  
Insert a last name for each individual in a series of family members. 

Examples: 

Original You enter 

John Brantley and his wife Elizabeth John Brantley, Elizabeth Brantley, 

 

Abbreviated names  

Type abbreviated names exactly as originally written (or as close as possible), but without periods.  Examples: 

Original You enter 

Rich’d  Rich’d 

Tim’
y
 Tim’y 

Benj. Benj 

Thos. Thos 

 

Handwriting issues  
 

Original You enter 

Double s written as sf or ff ss 

Confusion between capitalized L and S 

The letter that fits best with the remainder of 

the name.  What looks like “Lamuel” is most 

likely “Samuel,” and  “Semuel” is probably 

“Lemuel.” 

 

 

Full edit of your worksheet file 

The formal editing of your work is a lengthy process, but it is a crucial element of the indexing project.  It 

is divided into two parts.  The first part consists of a series of things that you will need to do before you 

submit your worksheet.  The second part involves correcting your worksheet based on the draft index that 

the BPM will produce for you. 

Part One of the Full Edit 

1. Put your most current worksheet file in a folder by itself. 
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2. Look for omitted names. 
Carefully compare each page image with your current worksheet file to make sure that you have 

not left out any names. 

 

3. Do a cursory check of your current worksheet file and correct misspelled names. (You’ll do a 

much easier and more thorough check after you receive your draft index from the BPM. 

 

4. Review the latest indexing instructions on page formatting and punctuation.  Some of these may 

have changed since you began indexing.  Make corrections as necessary. 

 

5. Check for formatting errors (for Book Project Managers only) 
Use the search feature in Word to find and correct any of these: 

 Question mark followed by space and then a comma (delete the space) 
 + symbol followed by space and then a comma (delete the space) 
 + symbol preceded by space and followed by a comma (delete the space) 
 Colon preceded by a space (delete the space) 

 Asterisk preceded by space (delete the space) 

 

6. Examine names with question marks and highlights. (for Book Project Managers only) 
You will probably recognize what many of these should be and can edit as needed.  If not, you can 

use the search feature in Word to help you.  Examples: 

 Jacob Parratt?,   
A search for the name Jacob revealed several occurrences of the name Jacob Barratt but 
not another Jacob Parratt, so the questioned entry was revised to: Jacob Barratt, 

 Polly Bri?.   
A search for the letters Bri produced only two surnames (Britt and Brister) that began 
with these letters.  A second look at the original page revealed that the name was 
probably (but not definitely) Brister, so the entry was revised to: Polly Brister?, 
 

7. On the first page of your current worksheet file, before any of the entered data, specify 

abnormalities such as:  

o Missing pages 
o Pages with the same page number (names from these must be entered as if they 

were from a single page) 
o Pages that are extremely difficult to read or can’t be read at all 

Email your worksheet 

Send your worksheet file to your assigned Book Project Manager as an email attachment, with the 
file’s name in the Subject field of the email. 

Draft index 

If your worksheet file is generally acceptable, the BPM will create a draft index from it and email it to 

you. 

Part Two of the Full Edit 

1. Print out the draft index you received from your BPM.  
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2. Go over this index, entry by entry.  Mark all questionable entries with a red pencil.  
 

3. Compare these marked index entries with the original page images (not your 
worksheet file). 
 

4. Correct the worksheet file (not the index) as needed.  Examples of index entries to look for 
and correct as needed:   
 
 A name appearing only once  

This is a potential misspelling.  Example: 
Jeremiah Bats is in the index only once, but there are index entries for Jeremiah Bass.  
When you check the original page for Jeremiah Bats, you see that it should have been 
typed as Jeremiah Bass, so you change it accordingly.  If the name is spelled clearly as 
Bats, then you would make a note to confirm that.  It might also be useful to search the 
index file in Word for the first name in a suspect entry (in this example, Jeremiah) when 
you need to compare it with other entries. 
(NOTE: It would not be unusual for an abbreviated name to occur only once in the index; 
for example, Tho. Spencer or Edwd Jackson.  Abbreviated names are to be typed exactly 
as they appear, but without any periods.) 
 

 An entry with four names and a period between two of them 
 For example: 
 
    Evans, John Taylor. William,  pg 6 
 
Go to the appropriate page in your worksheet file (Page 06, in this example) and change 
the period to a comma.  In this example, the original entries should have been: 
 
     John Evans, William Taylor,  
 

5. When you’ve finished: 

Resubmit your corrected worksheet file to your BPM.  Do not send the index you printed out 
and marked up.  
 
IMPORTANT: Store your corrected worksheet file, as it may be needed for future reference.  
Be sure to keep it separate from any superseded worksheet files. 
 

6. If there are no obvious errors in your corrected worksheet, the PM will create a new index 
from it and submit it to the Web site for posting.  Your name will appear in the hard copy and 
on the Web site as an indexer. 

Due to the scope and complexity of this project, there are likely to be errors in the indexes published on 

the Web site, even though all of the indexers and editors will have worked to keep them at a minimum.  

However, this need not be cause for embarrassment to anyone.  Sometimes errors cannot be identified 

until new discoveries are made.  Feedback will be solicited from users of the Web site and sent to the 

respective project managers.   
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Definitions & Responsibilities 

The Cobb Project  
The Cobb Project involves two parts.   

1. Digitizing of records on site at the Cobb courthouse.  This part of the project is complete except for retakes, 

which may be needed. It was accomplished in late 2009.    

2. Indexing of an estimated 150 thousand name entries taken from the digitized images mentioned above.  

Project Sponsor  
The indexing project is sponsored by the Powder Springs, Georgia Stake Young Men’s and Young Women’s  

Group, but in corporation with various other groups and volunteers who may step forward to participate.   

Project Manager (PM) 
The Indexing Project Manager (PM) is  for the young men Asa Hendrick; for young women is Sis Shell.   Each are 

responsible for the oversight of the indexing of the records digitally imaged in 2009 in Cobb County.  This is in 

keeping with a commitment of intent made at that time with Probate Judge, Kelli Wolk.  All book indexing 

assignments will be made through the PM
s 
and the draft entry results, after editing, will be sent to him/her.  By 

application of program software, the draft entries will be used to create a draft index to be ultimately be finalized 

and forwarded to the designated Cobb County Webmaster.  

Indexer 
An indexer is one who has volunteered to index a portion of a book.  Any person indexing 50* pages or more in 

any book will be named as a participant on the index title page or referenced addendum. The indexer is required to 

edit his/her own work before submission, but the final edit will be the responsibility of the "Book Project Manager" 

BPM and/or an assigned surname specialist.  
  

Book Project Manager (BPM) 
A book project manager is one who has taken the responsibility to index or oversee the indexing of a complete 

book.  He/she may index the entire book and receive full credit for the book project and be so credited on the index 

title page in the front of the court book, as well as the same on the on-line WEB site. The project manager may 

assign sections of the book to others to index.  Some assignments may involve whole families or specific groups 

accepted by the Project Manager.  The Project Manager, however, will be responsible for the final edit of the 

respective book, but may have access to a surname specialist for counsel.  

Surname Specialist 
A Surname specialist is one determined to be exceptionally qualified to recognize names mentioned in the court 

records.  With regard to the Cobb Project, anyone who has done research in the County for many years or is a life-

long resident of Cobb, is likely to be qualified to serve as a "Surname Specialist".  Also anyone who has 

successfully indexed or overseen the indexing of 700 or more pages of the collection may be so designated for 

certain books.  These are appointed at the direction of the PM. 

Project Consultant 

The Project Consultant is Ken Brantley.  All managers may call upon him for recommendations and clarification of 

issues at any time. 
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Common Surnames of Cobb County, Georgia 

1865-1900 
Submitted by _________________________ 

  

 

 

  
Barber 

Barns 

Bennett 

Blackwell 

Boyd 

Brawner 

Bullard 

Campbell 

Cook 

Davis 

Delk 

Dodgen 

Eason 

Florence 

Floyd 

Fowler 

Gann 

Glore 

Gober 

Haney 

Hansell 

Harbin 

Hembree 

Ivy 

Jolley 

Kemp 

Lee 

Leverett 

Lindly 

Marlow 

Meek 

Miller 

Moon 

Moss 

Nesbitt 

Oliver 

Pace 

Queen 

Reid 

Stroud 

Varner 

Wade 

Wallace 

 
 

Names to be added here as project progresses. 


